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The study of erythrocyte characteristics is carried out through different tests, including microscopy and image 

analysis. The purpose of this article is to develop a functional algorithm in the ImageJ software to identify the 

morphological characteristics of erythrocytes and to determine the variation in osmotic fragility when they are 

exposed to different conditions. The images were obtained using a Leica Aristoplan microscope and captured with 

a Leica DMC6200 camera connected to the equipment, and subsequently processed in ImageJ. The algorithm 

provides an orderly description of the process, from image calibration to the acquisition of quantitative results. 

This process includes calibration according to the microscope magnification, correction of possible image errors, 

and identification of cells to obtain parameters such as area, perimeter, roundness, and Feret’s diameter. The ap-

plication of the algorithm in ImageJ enables image processing that facilitates the morphological quantification of 

erythrocytes. The algorithm presented is efficient and reproducible, and can also be adapted according to user 

needs. Based on the analysis, it is concluded that the algorithm can be modified depending on specific require-

ments. Overall, the algorithm facilitates the use of ImageJ for the morphological quantification of erythrocytes. 
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In  

El estudio de las características de los eritrocitos se realiza mediante distintas pruebas, entre ellas la microscopía 

y el análisis de imágenes. El propósito de este artículo es desarrollar un algoritmo funcional en el software ImageJ 

para identificar las características morfológicas de los eritrocitos y determinar la variación de la fragilidad osmótica 

cuando estos son expuestos a distintas condiciones. Las imágenes utilizadas fueron observadas mediante un mi-

croscopio Leica Aristoplan y capturadas por una cámara Leica DMC6200 conectada al equipo, para posteriormente 

ser procesadas en el software ImageJ. El algoritmo describe de forma ordenada el proceso que se realiza desde la 

calibración de la imagen hasta la obtención de resultados cuantitativos. Este proceso incluye la calibración según 

el aumento del microscopio, la corrección de posibles errores en la imagen y la identificación de las células para 

la obtención de parámetros como el área, el perímetro, la redondez y el diámetro de Feret. La aplicación del algo-

ritmo en ImageJ permite un procesamiento de imágenes que facilita la cuantificación morfológica de eritrocitos. 

El algoritmo presentado es eficiente y reproducible, además puede ser adaptado según las necesidades del usuario. 

Tras el análisis, se concluye que el algoritmo puede ser modificado según los requerimientos del usuario. En con-

junto, el algoritmo facilita el uso de ImageJ para la cuantificación morfológica de eritrocitos. 
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Introduction 

 

Microscopy was a determining and relevant factor 

for the development of research on living organisms 

throughout history. It began with Robert Hooke in 

1665, when he invented apparatus with glass lenses 

to be able to observe, measure and record various 

phenomena, allowing him to be the first to describe 

the cell and observe the structure of tissues1,2. The 

microscope has become a universal tool used in dif-

ferent areas of research, for this reason, it gives infi-

nite possibilities to study the morphology, composi-

tion, structure and other characteristics of various liv-

ing organisms and inorganic matter. 

The characteristics of the cell were studied for a long 

time; the first microscopic investigations of blood be-

gan with Marcello Malpighi, who described capillary 

structures and tissues, questioning the beliefs about 

blood composition of his time. Subsequently, An-

tonie van Leeuwenhoek and Jan Swammerdam 

looked under a microscope at the blood cells, which 

they called "globuli rubri" (red blood cells)3. 

With the development of new technologies, studies 

on red blood cells have been perfected, allowing their 

shape, size, density, diameter and color to be charac-

terized. These properties are currently used for the 

diagnosis of various hematological diseases, such as 

anemia, including megaloblastic anemia4. 

Erythrocytes are blood cells present throughout the 

body, responsible for transporting oxygen to the tis-

sues and eliminating carbon dioxide generated in cel-

lular respiration5. 

A healthy erythrocyte is shaped like a biconcave disc 

with a depressed center, lacks a nucleus, and has a 

characteristic red color due to its high concentration 

of hemoglobin, an iron-rich protein. The average di-

ameter of an erythrocyte in an adult person ranges 

 

 

from 7 to 8 μm6. 

The shape, dimensions and characteristics of eryth-

rocytes observed under the microscope can be altered 

in the presence of diseases or changes in their physi-

ological conditions. A clear example is sickle cell 

anemia, which causes the deformation of erythro-

cytes into a sickle-shaped, making it difficult for 

them to pass through small blood vessels and favor-

ing hemolysis7. 

Among these diseases, many alterations can be de-

tected by morphological analysis of erythrocytes, and 

different techniques have made it possible to identify 

different types of anemia according to cell shape. On 

the other hand, conditions such as polycythemia 

(erythrocytosis) can be recognized by elevated red 

blood cell counts. Likewise, the pathological classi-

fication of these cells can be carried out by micro-

scopic observation6,8,9. 

To improve the visualization of blood cells under the 

microscope, various staining techniques have been 

developed to highlight their morphological charac-

teristics. Among the most commonly used in hema-

tology are Wright, Giemsa, and Leishman stains, 

each with specific applications. Wright staining, for 

example, is used in blood smears to differentiate cel-

lular components, staining the nuclei blue and the cy-

toplasm pink10,11. 

Stains facilitate the visualization of cell structures 

under a microscope; However, to achieve a more pre-

cise quantification of these characteristics, images 

are captured using cameras attached to the micro-

scope and their subsequent analysis with specialized 

software. 

The analysis of the differences in the images obtained 

is essential to identify variations and changes in liv- 
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ing systems or in structures that are difficult to per-

ceive with the naked eye. Thanks to technological de-

velopments, it is now possible to perform three-di-

mensional reconstructions of structures using tech-

niques such as high-resolution cryo-electron micros-

copy12. These advances have boosted science and al-

lowed for a deeper understanding of the behaviors 

and characteristics of living systems. 

Initially, computer programs were mainly used for 

image storage. Later, the first editing programs 

emerged, such as Adobe Photoshop13, which was one 

of the first to be applied to microscopy for image ed-

iting. Later, more specialized programs were devel-

oped, such as ImageJ in 1997, derived from the NIH 

Image14. Currently, microscopy makes it possible to 

capture and store images or videos of the observed 

phenomena, which can be analyzed using specialized 

software. Among these, FIJI, ImageJ15, Icy16 and Or-

bit17 stand out, which facilitate the identification and 

processing of structures, allowing them to be charac-

terized more clearly18. 

ImageJ is one of the most prominent programs in im-

age analysis and processing, widely used in the sci-

entific field19. It allows a rigorous analysis of visual 

data and is especially useful in the study of biological 

systems thanks to its wide variety of tools20. Being 

open source and free, it can be used from any com-

puter, which facilitates universal access. In addition, 

it has instructions and functions that make its use a 

simple and practical experience21. 

To make the most of free programs such as ImageJ, 

which facilitate information management and data 

analysis, it is necessary to standardize algorithms for 

the study of biological images, in order to simplify 

research and analysis of results. There are currently 

no standardized protocols that systematically de-

scribe the use of this program in the analysis of red 

blood cells, despite the fact that microscopic obser-

vation is a commonly used method for the detection 

of diseases. However, research has been carried out 

that performs cell counting on platforms such as 

MATLAB22 and others that propose specific methods, 

such as the one proposed by Chadha et al.23. 

The objective of this article is to propose an algo-

rithm for the analysis of erythrocyte images, which 

allows obtaining quantitative morphological param-

eters such as diameter, area, roundness and cell count 

through the use of ImageJ software. 

 

Materials and methods 

 

Patient preparation. Prior to taking samples, a com-

plete blood count was performed in the laboratory of 

the General Hospital of La Paz to rule out hemato-

logical alterations that could affect the results. The 

individual had a hematocrit of 49 %, within the nor-

mal values for his age and gender24. Once the healthy 

status was confirmed, an informed consent was 

signed for their participation in the study, as estab-

lished by the Bioethics Committee of the Bolivian 

Catholic University "San Pablo", La Paz campus. 

The research was carried out between November 

2023 and March 2024. 

Sample collection. Samples were obtained from the 

same individual to avoid data variability. A 3 mL 

sample of blood was taken daily for five consecutive 

days, at an ambient temperature of 25 °C, placed in 

tubes with EDTA as an anticoagulant (Vacuette, 

batch 454217). 

Preparation of the sample prior to observation. The 

blood was processed according to the method of 

Alonso-Geli et al.25; It was centrifuged at 1000 g for 

10 min to separate the plasma. Subsequently, 40 μL 

of the remaining globular package were taken and 
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washed in 4 mL of sodium chloride (NaCl) solution 

(Scharlab S.L., Spain, batch 11285202). This proce-

dure was repeated with 12 different concentrations of 

NaCl, 0.0, 0.1, 0.2, 0.25, 0.3, 0.32, 0.36, 0.4, 0.45, 

0.55, 0.7 and 0.9 %. Finally, the samples were cen-

trifuged again for 10 min in a centrifuge (Sigma, Ger-

many). 

With the erythrocyte package prepared, a drop was 

deposited on the slide, the sample was smeared and 

allowed to dry at room temperature (25° C) for 30 

min26. 

To improve the visualization and distinction of the 

erythrocytes in each sample, Wright's Dip Stat stain-

ing kit (Chemical Corporation, United States, lot 

A187) was used, which contains four 250 mL solu-

tions: fixative solution, eosinated stain, polychro-

matic stain, and rinse solution. The sample was 

stained according to the technique described by Li et 

al.27. Once the procedure was completed, it was left 

to dry for 1 h. Finally, a drop of dipex was added to 

preserve the preparation at room temperature and the 

coverslip was placed on top. 

Observation of the sample under a microscope. The 

samples were observed under a Leica Aristoplan mi-

croscope (Germany) with 40x, 50x and 100x lenses. 

The images were captured using a Leica DMC6200 

Pixel Shift camera (Germany), connected to the mi-

croscope. Images were recorded with each lens, se-

lecting the field that would allow the cell character-

istics to be differentiated more clearly. Once the ob-

servation was completed, the images were selected 

and coded for further analysis. 

Sample analysis in ImageJ. The ImageJ program was 

used, downloaded from the network. Once installed, 

the application was entered on the computer. To ex-

plore its tools, the File tab → Open Samples was 

used, which displays a menu of images preselected 

by the program. To start the analysis of the samples, 

File → Open was selected and the corresponding im-

age was loaded. The images analyzed were in TIFF 

format, which offers better quality for handling de-

tails; however, ImageJ accepts multiple formats such 

as PNG, GIF, and JPEG28. 

Once the image was selected, it was displayed on the 

screen. At the top of the window, below the toolbar, 

the file's name, format, resolution, color system, and 

size were displayed (Figure 1). Moving the cursor 

across the screen and selecting a point brought up the 

x and y coordinates of the selected area; by right or 

left click you could increase or decrease the size of 

the image window. 

 

 

 
Figure 1 Screenshot of ImageJ software showing the available 

toolbar 

 

Image calibration. To start working with the applica-

tion, it is necessary to calibrate the image according 

to the measurements of the microscope. To do this, 

an image of an object with known dimensions must 

be captured during the observation, which will be 

used as a reference image. It is essential to have a 

reference image for each lens used. 
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The procedure consists of opening the reference im-

age corresponding to the lens, selecting the line tool 

and drawing a straight line on the object whose meas-

urement is known. Then, in the Analyze menu, 

choose the Set Scale option; in the Known Distance 

field, enter the known measurement, and in Unit of 

Length, select the corresponding unit, thus adjusting 

the scale to the actual size of the image to be ana-

lyzed. Once the calibration is done, the units will be 

displayed according to those set by the user. In im-

ages taken with the same lens, the initial calibration 

is maintained; however, when changing lenses, the 

calibration process must be repeated (Figure 2). 

 

 

 
Figure 2 Image Calibration Process Algorithm in ImageJ Software 

Image processing. Once the calibration is done, the 

image to be analyzed is opened. From the menu, se-

lect Image → Adjust → Color Threshold; if you don't 

want to make additional settings, the pop-up window 

closes, generating a red background in the image. 

Subsequently, from the menu, Process → Binary → 

Make Binary is selected (Figure 3), converting the 

image to black and white. The background should ap-

pear black and the cells white; if this does not hap-

pen, you should go to Edit → Invert, which inverts 

the colors and sets the background to black and the 

cells to white. 

 

 

 
Figure 3 ImageJ Software Screenshot of a Step of the Image Pro-

cessing Algorithm 

 

If the cells cannot be distinguished from each other, 

because they are very close together, the Erode tool 

can be used, which reduces the contour of the white 

areas corresponding to the erythrocytes by one pixel. 

Finally, Process → Binary → Fill Holes is selected 

to ensure that the area calculation is complete (Figure 

4). 
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Figure 4 Image Processing Algorithm in ImageJ Software 

 

Visualization of results. First, select the Analyze → 

Set Measurements option and ensure that the re-

quired options are enabled. In this case, the following 

were used: Area, which determines the area of the 

cell; Perimeter, which calculates the perimeter of 

each cell; Shape Descriptors, a parameter that indi-

cates, in a range from 0 to 1, the similarity to a circu-

lar shape; Feret's Diameter, which measures the di-

ameter in a specific direction; and Add to Overlay, 

which assigns a number to each cell in the image 

based on the count made. Finally, it is necessary to 

verify that in the Redirect to option so that the name 

of the image you are working on appears, to ensure 

that the processing is done correctly (Figure 5). 

 

 

 
Figure 5 Algorithm for Performing Results Display in ImageJ Soft-

ware 

 

Particle analysis. The next step is to select Analyze 

→ Analyze Particles. With this option it is possible 

to modify the parameters according to the needs of 

the analysis; in this case, the settings preset by the 

application were maintained: in Size from 0 to ∞, in 

Circularity from 0 to 1, and in Show Overlay Masks 

was selected. In addition, the Display Results (to dis-

play results), Clear Results (to avoid repetitions), and 

Exclude on Edges (to exclude incomplete cells at the 

edges of the image) options were enabled. 
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After completing this procedure, the image was 

shown with a black background and each cell was 

marked with a color and a number (Figure 6). Simul-

taneously, a table was generated with all the results.  

Inconsistent data can be adjusted by delimiting the 

parameters in Set Measurements. 

 

 

 
Figure 6 Results of the configurations used in the images to count the 

cells present 

 

Summary and storage of results. Finally, you can get 

a summary of the data in the same table shown. Re-

sults → Summarize is selected, and the data will ap-

pear in summary form at the bottom. In Table 1 they 

are presented in a similar way to how they are shown 

in the software. Finally, if you want to save these re-

sults, you select Results → File → Save, which al-

lows you to store them in Excel or TXT format. 

 

Results 

 

The final algorithm developed for implementation in 

the ImageJ software is the result of the process de-

scribed in the previous stages (Figure 7). This algo- 

rithm facilitates the analysis of the images and allows 

obtaining quantitative morphological parameters of 

the erythrocytes observed, such as the area, perime-

ter, roundness and diameter of Feret. In addition, it 

seeks to optimize microscopy image processing, en-

suring that the results are reproducible, accurate, and 

easy to interpret. 

This algorithm seeks to facilitate the morphological 

analysis of erythrocytes and offer a tool adaptable to 

different types of biological samples with similar 

morphology. In this way, the use of ImageJ is sim-

plified for researchers who require a standardized 

and functional procedure in cell analysis. 

All values were automatically calculated by the pro-

gram after the algorithm was applied. As can be seen, 

the standard deviations of the parameters of area, pe-

rimeter, circumference and Feret diameter are low, 

which shows an adequate consistency of the proce-

dure and a correct delimitation of the image (Table 

1). From this algorithm, a more specific analysis of 

the morphological variations of the samples under 

different osmotic conditions was carried out, apply-

ing the proposed method and following the method-

ology described in the document. 

The analysis shows an upward trend in the average 

area of erythrocytes as the concentration of NaCl in 

the medium decreases (Table 2). At the same time, a 

decrease in the Feret diameter is observed. Standard 

deviation values are kept low relative to the averages, 

confirming the accuracy of the algorithm. These 

changes indicate that the method is capable of detect-

ing morphological differences. Overall, the results 

show that the algorithm designed in ImageJ allows 

quantifying morphological parameters in a reproduc-

ible way, facilitating the obtaining of verifiable data 

under different observation conditions. 

 



Agramont Morales et al.                                                                                                                                         J. Selva Andina Res. Soc. 

______________________________________________________________________________________________________________ 

21  

Tabla 1 Resultados de la muestra de sangre a 100x analizada en ImageJ 

 
 Label Area Perim. Circ. Feret FeretX FeretY FeretAngle MinFeret AR Round Solidity 

77 Mean 0.013 0.509 0.674 0.147 861.882 581.474 100.048 0.121 1.212 0.843 0.942 

78 SD 0.003 0.133 0.149 0.025 521.309 312.855 51.697 0.013 0.212 0.108 0.033 

79 Min 0.01 0.396 0.168 0.122 20 19 8.315 0.088 1.006 0.443 0.834 

80 Max 0.028 1.006 0.869 0.249 1792 1152 178.85 0.166 2.256 0.994 0.977 

 

Tabla 2 Resultados de valores promedio de área y diámetro de eritrocitos a distintas concentraciones de NaCl (100x) 

 

NaCl concentration (%) 
100x magnification 

Parameter Area [µ2] Feret [µm] 

0.9 

mean 15.52315 5.05292 

SD 049921 0.09452 

Min 15.17016 4.98608 

Max 15.87615 5.11975 

0.4 

mean 25.96679 6.41365 

SD 6.15619 1.33875 

Min 18.07716 4.97799 

Max 40.60766 9.86242 

0.32 

mean 19.06149 6.06803 

SD 3.70165 0.5807 

Min 12.6247 5.14902 

Max 24.4628 7.09696 

 

 

 
Figura 7 Algoritmo final para realizar la caracterización de los eri-

trocitos 

Discussion 

 

Many of the tools used for observation in ImageJ are 

also available in other programs. In the study by 

Mejía & Alzate29, the analysis of erythrocytes ac-

cording to their shape was performed on the 

MATLAB platform, where image processing and 

morphological characterization were carried out ac-

cording to their shape and size. These authors point 

out that it is possible to use MATLAB to measure 

morphological parameters in microscopy. The pref-

erence for ImageJ over MATLAB lies in its accessi-

bility and ease of use30. Unlike MATLAB, which re-

quires a paid license and advanced programming 

skills as it is not specialized in image analysis, Im-

ageJ is free, easy to install, and has a large commu-

nity of users, as well as multiple tools aimed at ana-

lyzing biological images. 
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In accordance with these advantages, several authors 

have highlighted the relevance of open computa-

tional tools. Li et al.31. They conducted a review on 

the use of free platforms in the analysis of biomedical 

images, underlining their role in the standardization 

and accessibility of scientific methods. In addition, 

they pointed out that most studies lack parameters 

that allow replicating their procedures. These find-

ings support the use of ImageJ as an effective and 

accessible platform, promoting the creation of repro-

ducible algorithms for the morphological characteri-

zation of blood cells, especially in academic and re-

search settings where reproducibility and low cost 

are essential. 

The algorithm developed in ImageJ could be comple-

mented in the future with deep learning strategies to 

create automated diagnostic systems that combine 

the precision of digital processing with the intelligent 

interpretation of biomedical images. Cakmak & Pa-

cal32 showed that artificial intelligence can be used in 

the diagnosis of anemia using machine learning tech-

niques, taking advantage of the ability of these tools 

to detect morphological patterns and classify blood 

cells automatically, thus contributing to the early de-

tection of hematological diseases. 

In addition, recent advances in artificial intelligence 

have highlighted the potential of integrating image 

analysis algorithms with deep learning models. An 

example is the tool called RedTell, designed to inter-

pret the morphology of erythrocytes33. Similarly, 

studies such as those by Foy et al.34 and Ghosh et al.35 

have pointed out the usefulness of artificial intelli-

gence to facilitate the analysis and collection of data 

on the morphological characteristics of erythrocytes. 

The algorithm used in this research is specific to 

measure morphological parameters of erythrocytes. 

However, its structure can be adapted to the analysis 

of cells with circular or quasi-spherical morphology. 

In future work it would be convenient to evaluate 

their performance in cells with different shapes or ir-

regular morphology. 

Finally, it is important to consider certain recommen-

dations that prevent potential errors that can affect 

the performance of the algorithm. These include the 

correct preparation of the sample, such as the delicate 

performance of the smear26; if it does not allow you 

to observe areas where the cells are scattered, the im-

age cannot be used, even with the Erode correction 

tool. The same happens when staining is not per-

formed properly27. Another frequent error is related 

to the identification and delimitation of cell size: 

structures other than the object of study may appear 

in the image, such as leukocytes, which stand out af-

ter staining due to their size (Figure 1). This problem 

can be ruled out by selecting the Area parameter, lim-

iting the component count. Also, the taking of the im-

age for calibration must be precise, since it is decisive 

in the entire process36. 

In addition, correct calibration of the microscopy 

with the micrometer reticle is essential to ensure the 

reliability of the measurements. Each objective lens 

must be calibrated independently, as variations in 

magnification change the conversion scale from pix-

els to micrometers. Overall, the results and consider-

ations presented reinforce the validity of the algo-

rithm as a reliable tool for image analysis aimed at 

the morphological study of erythrocytes. The main 

contribution of this work lies in the standardization 

of a reproducible and accessible algorithm for any 

scientist who is starting out in image analysis using 

free software such as ImageJ, allowing accurate data 

to be obtained without resorting to high-cost pro-

grams. The implementation of this algorithm in Im-

ageJ facilitates the study of hematological images 
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and can be adapted to the analysis of cells with simi-

lar morphology, constituting a solid basis for future 

research. In this way, the proposed algorithm contrib-

utes to the standardization of the morphological anal-

ysis of erythrocytes in research. 
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